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Creating an EndNote Library/Database 

1. Open the EndNote program.  

2. Click on the picture in the middle which says “Create a new EndNote 

Library” 

3. Click OK  

4. In the “File-Name” box, type in a name for your library/database, e.g. 

REFERENCE or BIBLIOGRAPHY. 

5. Click SAVE button and you have created an EndNote Library with 

three Panels: 

 A Groups Panel 

 A Library Panel 

 A Search Panel 
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To Search EndNote Using Temporary Library Mode 

1. Open your EndNote Library 

2. At the left hand side of the ribbon, click on the “Globe” icon 

3. Go to TOOLS, click on ONLINE SEARCH  

4. A CHOOSE A CONNECTION window opens up listing online library 

catalogs and databases 

5. Select a library online catalog or database and click CHOOSE and the 

search panel will show that you are now connected to the online catalog 

or database. 

6. Enter your search terms and click SEARCH 

7. A Confirm Online Search window opens up showing the number of 

retrievals 

8. Click OK and the citations will be imported into the Temporary library 

9. Select the citations you want to keep 

10. Go up to REFERENCES and select COPY REFERENCES TO and 

select the EndNote library you want the citations to go to 

11. Your selected citations will be moved to the EndNote library you have 

selected (you will see them by clicking on ALL REFERENCES 

12. Close the Temporary Library 

13. You’ll be asked if you want to discard all the online references 

14. Click OK 

15. Go to FILE and open up your library and you will see the citations have 

been imported 
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To Search EndNote Using Permanent Library Mode 

1. Open your EndNote Library 

2. At the left hand side of the ribbon, click on the “Globe plus Books” 

icon 

3. Go to TOOLS, click on ONLINE SEARCH  

4. A CHOOSE A CONNECTION window opens up listing online 

library catalogs and databases 

5. Select a library online catalog or database and click CHOOSE and the 

search panel will show that you are now connected to the online catalog 

or database. 

6. Enter your search terms and click SEARCH 

7. A Confirm Online Search window opens up showing the number of 

retrievals 

8. Click OK and all the citations will be imported into the Permanent 

library 

9. Select the citations you don’t want to keep 

10. Go up to REFERENCES and scroll down to REMOVE 

REFERENCES TO TRASH  

11. On the GROUPS panel, click on ALL REFERENCES to see all the 

citations in your permanent Library 
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Importing Search Retrievals through Filters 

(This procedure is used when you have to import your 

search retrievals.  

Save your search retrievals as a text file with field tags (e.g. AU, TI, SO, etc.) 

 

1. Open the EndNote Library. 

2. Go to FILE and scroll down to IMPORT. (An IMPORT window 

appears). 

3. Click on Choose File button. 

4. Go to the site where you have saved your search file (e.g. the desktop), 

and click on the file. 

5. Click OPEN and an Import Window opens up. (The filename should 

appear on the Import Data File window) 

6. From the “Import Option” window, select the database (e.g. PubMed, 

CABDirect, Web-of-Knowledge) from the appropriate provider (e.g. 

NLM, SP, CSA) that you searched in. Click on Other Filters the filter 

is not on the List. (The name of the import filter will appear in the 

“Import Option” window) 

7. From the “Duplicates” window, select your option to exclude 

duplicates or to import all. 

8. Click the IMPORT button. (Your EndNote Library/Database will now 

have all the imported citations). 
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 “Exporting” Search Retrievals from CABDIRECT  

1. After retrieving your search results from the database, mark the needed 

citations. 

2. Then click on Export Marked Citations under Tools 

3. Then choose the format to want to export and click the Export EndNote 

(RIS) format button. 

4. An Opening Citations.Ris window opens up 

5. Click the radial button to the left of Open with ResearchSoft Direct 

Export Helper (default) and then click O.K. 

6. The citations will be imported into your EndNote Library. 
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“Exporting” Search Retrievals from COMPENDEX 

(from Engineering Village) 

1. After retrieving your search results from the database, mark the needed 

citations, and click the Download button. 

2. “Download Selected Records” window opens up 

3. Check the radial button to the left of “RIS, EndNote, Reference 

Manager”  

4. Click the Download button and “You have chosen to open” window 

opens up 

5. Check the radial button to the left of “ResearchSoft Direct Export 

Helper” and then click OK 

6. The marked citations will be imported into your EndNote Library 
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 “Exporting” Search Retrievals from EBSCOhost databases 

(e.g. ERIC, PsycINFO, etc) 

1. After retrieving your search results from the database, mark the needed 

citations by clicking on Add to Folder below each citation you want to 

keep. 

2. Then click the Save Searches/Alert above  

3. Click on the folder-icon in the “blue ribbon” above. 

4. A screen with the citations that you Added To Folder appears  

5. Check the square boxes to the left of the citations. 

6. Click on the Export icon (the one with a page and an arrow) 

7. Check radial button to the left of Direct Export to EndNote, Procite, or 

Reference Manager 

8. Click SAVE 

9. An Opening Delivery window appears  

10. Check the radial button to the left of Open with (Web Export Helper) 

and click OK. This will open up the EndNote program and a Select a 

Reference Library Window opens up. 

11. Go to where your EndNote database is located (e.g. desktop) 

12. Click on the Library and then click OPEN and the citations will be 

imported.  
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Create Smart Group 

1. Open your EndNote Library and click All References 

2. Click on GROUPS above and scroll down to Create Smart Group and 

a Smart Group Window opens up. 

3. In the Smart Group Name window enter the name of the Group you 

want to create e.g. Iron 

4. Click the arrow in the window which has “Author” and select the field 

you want EndNote to search, e.g. Keywords, and in the blank window to 

the right of it enter the term, e.g. Iron 

5. Then click the arrow in the window which has “Date” and select 

Abstract and in the blank window to the right of it enter the term to be 

searched. 

6. Repeat the procedure for the third window which shows Title. 

7. In the extreme left hand column, select the Boolean OR in both the 

windows 

8. Then click the Create Button 

9. The new Smart Group will be created showing the number of Iron-

citations in your Endnote Library.  

10. To enter the word stem of a word to catch singular and plural and other 

variant forms of the word, e.g. Fluorescent, Fluorescence, etc., enter the 

Word Stem, e.g. Flouresc and in the middle column where it says 

Contain, click on the arrow and select Word Begins With  
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Create Custom Group 

1. Open your EndNote-X2 Library and click All References 

2. Click on GROUPS on the top of the screen and scroll down to Create 

Group 

3. On the Group Panel on the left hand side of the screen, a New Group 

opens up under Custom Groups 

4. Type in the name of the group you want to create, e.g. Reviews, or 

Methodology etc. and press ENTER 

5. Then click All References to go to your Library 

6. Hold down the CRTL-key and select the citations you want to put into 

the Group 

7. Release the CRTL-Key 

8. Then click on one of the citations and drag and drop (the other citations 

that you have selected will follow) into the (Reviews) group that you 

have created 

To Delete Group 

1. Click on the group to be deleted 

2. Go up to GROUPS and select Delete Group 
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To Delete Citations 

1. Open your EndNote Library and click on All References 

2. Select citation to be deleted from your EndNote Library 

3. Go up to REFERENCES 

4. Scroll down to MOVE REFERENCES TO TRASH 

To Retrieve from Trash 

1. Click “Trash” in the Group Panel on the left hand side of the screen.  

2. The citation will appear in the “Reference Panel”, i.e your EndNote 

Library. 

3. Click on this citation and drag and drop citation into ALL 

REFERENCES 
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Entering Images into EndNote Library 

1. Open your EndNote Library 

2. Go to REFERENCES and select New References. A “New Reference” 

Window opens up.  

3. From the Reference Type window’s pull-down menu, select Figure. 

4. Enter the name of the creator, title of the image, date, etc. 

5. When you get to the Figure field click on it and go up to 

REFERENCES above and select Figure and Attach Figure. 

6. An “Attach Window” opens up 

7. Click the Choose File button 

8. Go to where you saved your image (e.g. desktop or a folder) and 

highlight it and click OPEN 

9. The image will appear in the Figure Field.  

10. Go the “Caption” field and enter a caption (this is optional) 

11. Close the entry it will be saved into your EndNote Library 
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Entering Charts, Tables, Diagrams, PDF-files, and 

PowerPoints into EndNote Library 

1. Open your EndNote Library 

2. Go to REFERENCES and select New References. A “New Reference” 

window opens up. 

3. At the Reference Type window on top, click on the down-arrow and 

select Charts or Tables from the pull-down menu.  

4. Enter the data that you want to enter for the Diagram, Table, Graph, 

etc. 

5. When you get to the Figure field click on it and go to REFERENCES 

and select Figure and Attach Figure 

6. An “Attach Figure” window opens. Click the Choose File button. 

7. At the Look In window select the site where you have saved your 

diagram, e.g. the Desktop or Folder. 

8. Locate the Diagram, Table, Graph, Power Point or PDF file you want 

to insert and Click on the file and then click OPEN 

9. The New Reference window re-appears, showing an icon of imported 

item in the figure Field. 

10. Go to the Caption field and type in a caption for your Table (this is 

optional) 

11. Close the window and the imported Diagram, Table or Graph will be 

saved into your EndNote Library. 
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Importing a PDF into an Image field in a citation record in 

EndNote Library 

1. Open the EndNote Library 

2. Go to TOOLS and scroll down to SEARCH LIBRARY 

3. Enter search terms and click SEARCH 

4. Double click on the retrieved citation to open the citation 

5. Scroll down and click on the Figure field.  

6. Go back up and click on REFERENCES and scroll down to Figure and 

Attach Figure.  

7. The Attach Figure window opens, click CHOOSE FILE button. 

8. Go to the location (e.g. desktop, My Document folder, etc) where 

you’ve saved your PDF file. 

9. Click on the PDF file and then click OPEN 

10. The PDF file will be imported into the citation. 

11. Close the citation. 
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Manually Entering Bibliographic Citations/References  

This is the procedure for entering references such as books, book chapters, proceedings, electronic 

citations, patents, etc. and articles not available through database searches.  
 

1. Open the EndNote Library. 

2. Go to REFERENCE and select New Reference 

3. (This opens up an empty New Reference Window) 

4. At the Reference Type window click on the arrow to the right of the 

window and select the reference type you want to enter manually (e.g. 

book section, conference paper, patent, thesis, etc)  

 

5. Enter the bibliographic data into each of the fields in the reference. 

(The information on the Title page of the publication is essential 

information for EndNote to cite that publication correctly)  

6. For Authors, enter each author on a separate line.  

7. When you have finished, CLOSE the reference to save it to the 

EndNote library 
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Inserting References from EndNote Library into Manuscript 

and Formatting Bibliography  

1. Open the EndNote Library that contain the references you wish to cite 

and minimize it so that it will not be in the way. 

2. Open the Word manuscript  

3. Click on EndNote on the tool-bar. 

4. Position the cursor in the text in your Word-document where you would 

like to put the citation.  

5. In the Citation Section click on the arrow next to Insert Citation and scroll 

down to Find Citation. 

6. A Find Citation(s) window opens up 

7. Enter your search for the references in the “FIND” window, and click the 

Search button. (Reference(s) matching your search will be retrieved)  

8. Click on the reference(s) you want to cite and then click the INSERT 

button on the lower right hand corner 

9. Repeat steps 4 through 8 until you have cited all your references.  

10. To format the bibliography, go to the Bibliography Section and click on 

the arrow next to Bibliography. 

11. An EndNote Format Bibliography window opens up. 

12. Click the BROWSE button on the right side of the With Output Style 

window  

13. Select the journal/bibliographic style you want from the With Output 

Style window and then click the OK button and your citations will be 

formatted according to the style chosen. 
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Incorporating Photographs, Charts, Graphs, Tables, etc. in 

the figure field into the Manuscript  

1. Open the EndNote Library that contains the figures you wish to incorporate 

into your manuscript and minimize it so that it will not in the way . 

2. Open the manuscript that you have saved on your Word Processing 

Program (e.g. Microsoft Word) 

3. Click on EndNote on the tool-bar.  

4. Position the cursor in the text in your Word-document where you want the 

image or figure to appear. 

5. In the Citation section, click on the arrow next to Insert Citation and scroll 

down to Find Figure. 

6. An EndNote Find Figure(s) window opens up 

7. In the Find box, enter the name you have assigned to the Photograph, Chart 

or Table in your EndNote Library which you want to insert.  

8. Click SEARCH (EndNote displays a single matching reference. The file 

attachment icon appears in the lower part of the screen) 

9. Click the INSERT button at the lower right corner of the screen.(The 

Photograph,Chart or Table will load slowly and appears at the location 

where you want it to be) 

10. To resize the incorporated Photograph, Chart or Table to fit on the page, 

Click on a corner of the photograph/graph/chart and then hold down the 

SHIFT-key, and drag the photograph/graph/chart to resize it proportionally.  

11. Go To FILE and SAVE (since it is now a Word File)  
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E-Mailing a Copy of EndNote Library 

1. Open EndNote Library, and Click on All References  

2. Go to FILE 

3. Scroll down to COMPRESSED LIBRARY ….. and click on Create & 

Email ….. 

4. This saved compressed copy of the library will have an extension .enlx 

5. Then click Next  

6. SAVED the compressed library on the desktop or folder 

7. This saved copy of your EndNote Library can then be send to your 

collaborator as an attached document to your e-mail  

Copying an EndNote Library into another EndNote Library 

1. Double click on the library with an extension .enlx to open it 

2. Go to EDIT and SELECT ALL 

3. Go to EDIT and COPY (you have now copied the library) 

4. Open the library2 you want to copy to 

5. Go to EDIT and PASTE 

6. The citations are now pasted in your library2 and they are high-lighted 
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Sending a Group from EndNote 

1. Open the EndNote Library and click on the Group you want to send 

2. Click on a citation and then press CTRL+A to highlight all the 

references in the group 

3. Go to FILE and scroll down to EXPORT. An Export File Name 

window opens up 

4. Set the output style to Refman (RIS) Export in the Output Style 

window 

5. Make sure that Export Selected Reference box is checked 

6. SAVE the references as a text file on the desktop 

7. Save this text file as an attachment in your e-mail 

8. When your colleague receives the file, he/she IMPORT it into his/her 

EndNote library selecting Refman(RIS) as the filter 
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Set EndNote to Not Import Duplicates 

1. Open your EndNote library 

2. Go to EDIT 

3. Select PREFERENCES and the Endnote Preferences Window opens 

up. 

4. Select Duplicates on the left hand panel 

5. On the right hand column, under Compare references based on the 

following Fields, check all the square boxes next to the fields on the 

list.  

6. Under the Online Search Results, check the square box next to 

Automatically discard Duplicates 

7. Then click OK  
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Downloading Output Styles from EndNote Homepage 

1. Activate browser and go to EndNote’s homepage at: http://www.endnote.com 

2. Click on support & services 

3. Scroll down to Downloads and select Output Styles and click More… 

4. The EndNote Output Styles window will appear. 

5. Click the Sorting Options tab  

6. Click on the arrow of the “Sort by” window and select  

7. either Discipline or Style Name or Date 

8. Click the Re-sort Files button on the right side of the screen, and the 

output styles will be sorted by what you have selected, e.g. the discipline 

or the Journal Style Name or Date.  

9. Scroll and locate the journal output style you want to download, e.g. 

Veterinary Microbiology, Agricultural and Forest Entomology, etc. 

10. Click on the Download (on the far right) for the selected journal style, and 

“You have chosen to open” window opens up. 

11. Click the radial button to the left of Save File and then click OK. 

12. Save the downloaded style to the desktop.  

13. You have now downloaded the journal output style. Close the EndNote 

Homepage. 

14. Go to the Desktop and right-click on the “downloaded journal output 

style” icon and scroll down and click CUT.  

15. Double-click My Computer to open the C-Drive and then open the 

Program File folder. 

16. Locate and open the EndNote folder. 

http://www.endnote.com/
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17. Go to EDIT and PASTE. The downloaded journal output style icon will 

appear on the screen. 

18. Click on the downloaded journal output style icon and drag and drop the 

icon into the Styles folder. You have now added the downloaded journal 

output style to your folder of output styles.  
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Downloading Connection Files from EndNote Homepage 

 

1. Activate browser and go to EndNote’s homepage at: 

2. http://www.endnote.com 

3. Click on support & services 

4. Scroll down to Downloads and select Connection Files and click More … 

5. The EndNote Connection Files window will appear 

6. Click on the Sort by arrow and select what you wish to sort by (e.g. date, database or provider) 

7. Click the Re-sort Files button on the right side of the screen, and the Connection Files will be 

sorted by what you have selected 

8. Scroll and locate the Connection File you want to download 

9. Click on the Download (on the far right) for the selected Connection File. 

10. Check the radial button for Save File and then click OK. 

11. Save the downloaded Connection File on the desktop. 

12. You have now downloaded the Connection File. Close the EndNote Homepage. 

13. Go to the desktop and right-click on the “Downloaded Connection File” icon and then scroll 

down and click CUT  

14. Double click My Computer to open the C-Drive  

15. Locate the Program File folder and open it 

16. Locate and open the EndNote folder 

17. Go to EDIT and PASTE.  The downloaded Connection File icon will appear on the screen 

18. Click on the downloaded Connection File icon and drag and drop the icon into the 

Connections folder. You have now added the downloaded Connection File into the folder. 

  

http://www.endnote.com/
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Merging Documents 

1. Open your EndNote Library that you used to write your document and 

minimize it. 

2. Open the document to be merged. 

3. Click on the EndNote tab on top 

4. Choose  Convert Citations and Bibliography and  Convert to 

Unformatted Citations 

5. Press  [CRTL]+A on the keyboard to highlight everything 

6. Press  [CRTL]+C to copy the highlighted text 

7. Close the document and you’ll be asked whether you want to save the 

changes, click NO 

8. Then create a blank Word document and press  [CRTL]+V to paste 

and then SAVE 

9. Repeat Steps 2 through 7 until all the documents are pasted in the 

merged Word document 

10. Once you have pasted all the documents in the merged Word document 

click the EndNote  tab and Format the Bibliography.   

11. A Bibliography will be formatted at the end of  the merged document 
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To Enter Corporate Authors 

a. To Enter a Corporate Author, put a comma after the name: 

e.g.  U.S. Department of Agriculture, 

Apple Computer Inc, 

2. This ensures that the entire name is treated as a first name, so no name 

manipulation will be applied. 

3. If the Corporate Author name includes a comma in the name itself, use 

two commas in place of the first comma: 

e.g. University of California,, Irvine 

EndNote treats this as a last name followed by a blank first name. Then, 

everything after the (blank) first name is appended, including a second 

comma in the name. The formatted result is the Corporate Name with 

the comma in place. 
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Edit (Add or Remove) Citations in Manuscript 

1. Open the EndNote Library and minimize it 

2. Open the manuscript that you want to edit 

3. Click on the EndNote Tab on top of the screen 

4. Click on Edit & Manage Citation(s)   

5. A window opens up showing your citations 

6. Click on the citation you want to delete and then click the arrow next to 

Edit Reference   

7. On the sub-menu that appears click  Remove Citation and then  O.K. 

(the citation is removed from the in-text reference but it is still in the 

Bibliography) 

8. Format the Bibliography again and the citation will be deleted from the 

Bibliography. 

9. Close your document and you’ll be asked if you want to save the 

changes 

10. Click Yes 
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Hidden Codes Appearing In Word Document 

On Windows: Word 2007 
 

1. Within Microsoft Word 2007 click the Office icon in the upper left, and 

then click “Word Options” at the bottom of this window. 

2. Click on the  Advanced option on the left hand side and scroll down to 

the section titled “Show Document Content” 

3. Uncheck the item titled  “Show Field Codes Instead of their values”  

and click “OK 

4. The document should now appear normal 

 

On Windows: Word 2003/2002/2000 
 

1. In Word, go to the “Tools” menu, and select “Options” 

2. Here, on the “View” tab, uncheck the box named “Field Codes” 

3. Click “OK” 

4. The document should now appear normal 

 

On A Macintosh: 
 

1. In Word, go to the “Word” menu, and select “Preferences” 

2. Here, on the “Menu”, uncheck the box named “Field Codes” 

3. Click “OK” 

4. The document should now appear normal. 

 
This setting is a universal setting for Word, so making this change should fix any documents that 

are currently displaying the field codes 
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Merging EndNote Libraries 

1. Open both EndNote libraries. You can use the Window menu to switch 

between the two 

2. In one library, click on the EDIT menu and click Select All 

3. Click on the Edit menu again and select Copy 

4. Switch to the destination library 

5. Click on the Edit and select Paste 
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Importing PDF and Generates Citation in EndNote Library 

With EndNote-X4 you’ll be able to import the PDF file, and if that article has 

a DOI number EndNote-X4 will automatically generate a bibliographic 

citation to go with the PDF.  This way, you don’t have to import the 

bibliographic citation. The procedure is as follows: 

1. Open your EndNote-X4 Library 

2. Go to File and scroll down to Import  

3. Choose File in the Sub-Menu that opens up. 

4. An Import File window opens up 

5. Click the Choose … button and go to where you store your PDF file, 

highlight it and click Open 

6. In the Import Options window choose PDF 

7. Then click Import 

8. The PDF file will be imported and if the article has a DOI number a 

citation will also be generated for the PDF full text. 
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Importing a Folder of PDF files 

With EndNote-X4 you’ll be able to import a whole folder of PDF files. For 

those articles with DOI numbers, EndNote-X4 will automatically generate 

bibliographic citations to go with those PDFs.  This way, you don’t have to 

import the bibliographic citations. The procedure is as follows: 

1. Open your EndNote-X4 Library 

2. Go to File and scroll down to Import  

3. Choose Folder… in the Sub-Menu that opens up. 

4. An Import Folder window opens up 

5. Check the square box to the left of Include Files in the Subfolders 

6. Then click the Choose … button and go to where you store your folder 

of PDF files, highlight it and click OK 

7. In the Import Options window choose PDF 

8. Then click Import 

9. The PDF files in the folder will be imported and for those articles that 

have  DOI numbers citations will also be generated. For those without, 

the PDFs will be imported without the corresponding citations. 
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Setting EndNote to Maximize Full Text Search 

1. Open your EndNote Library 

2. Go to EDIT and click on PREFERENCES to open up the Endnote 

Preferences window 

3. On the left hand column click on FIND FULL TEXT 

4. Check the square boxes for:  ISI Web of Knowledge; DOI;  PubMed;  

Open URL. 

5. In the Open URL Path, enter 

http://su8bj7jh4j.search.serialssolutions.com/  

6. For Authenticate with, enter 

https://login.ezproxy.lib.vt.edu:2443/login?qurl= 

7. This allows you to access the library resources from off-campus like 

your home or off-campus facilities. 

8. Then Click OK 

 

 

http://su8bj7jh4j.search.serialssolutions.com/
https://login.ezproxy.lib.vt.edu:2443/login?qurl

